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Understanding Embedded - FPGAs (Field
Programmable Gate Array)

Embedded - FPGAs, or Field Programmable Gate Arrays,
are advanced integrated circuits that offer unparalleled
flexibility and performance for digital systems. Unlike
traditional fixed-function logic devices, FPGAs can be
programmed and reprogrammed to execute a wide array
of logical operations, enabling customized functionality
tailored to specific applications. This reprogrammability
allows developers to iterate designs quickly and implement
complex functions without the need for custom hardware.

Applications of Embedded - FPGAs

The versatility of Embedded - FPGAs makes them
indispensable in numerous fields. In telecommunications,
FPGAs are used for high-speed data processing and
network infrastructure. In the automotive industry, they
support advanced driver-assistance systems (ADAS) and
infotainment solutions. Consumer electronics benefit from
FPGAs in devices requiring high performance and
adaptability, such as smart TVs and gaming consoles.
Industrial automation relies on FPGAs for real-time control
and processing in machinery and robotics. Additionally,
FPGAs play a crucial role in aerospace and defense, where
their reliability and ability to handle complex algorithms
are essential.

Common Subcategories of Embedded -
FPGAs

Within the realm of Embedded - FPGAs, several
subcategories address different needs and applications.
General-purpose FPGAs are the most widely used, offering
a balance of performance and flexibility for a broad range
of applications. High-performance FPGAs are designed for
applications requiring exceptional speed and
computational power, such as data centers and high-
frequency trading systems. Low-power FPGAs cater to
battery-operated and portable devices where energy
efficiency is paramount. Lastly, automotive-grade FPGAs
meet the stringent standards of the automotive industry,
ensuring reliability and performance in vehicle systems.

Types of Embedded - FPGAs

Embedded - FPGAs can be classified into several types
based on their architecture and specific capabilities. SRAM-
based FPGAs are prevalent due to their high speed and
ability to support complex designs, making them suitable
for performance-critical applications. Flash-based FPGAs
offer non-volatile storage, retaining their configuration
without power and enabling faster start-up times. Antifuse-
based FPGAs provide a permanent, one-time
programmable solution, ensuring robust security and
reliability for critical systems. Each type of FPGA brings
distinct advantages, making the choice dependent on the
specific needs of the application.
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Mounting Type Surface Mount

Operating Temperature -40°C ~ 100°C (TJ)

Package / Case 484-BBGA

Supplier Device Package 484-FPBGA (23x23)
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Figure 2-4. General Purpose PLL Diagram

Table 2-4 provides a description of the signals in the PLL blocks. 

Table 2-4. PLL Blocks Signal Descriptions

Delay Locked Loops (DLL)
In addition to PLLs, the LatticeECP3 family of devices has two DLLs per device. 

CLKI is the input frequency (generated either from the pin or routing) for the DLL. CLKI feeds into the output muxes 
block to bypass the DLL, directly to the DELAY CHAIN block and (directly or through divider circuit) to the reference 
input of the Phase Detector (PD) input mux. The reference signal for the PD can also be generated from the Delay 
Chain signals. The feedback input to the PD is generated from the CLKFB pin or from a tapped signal from the 
Delay chain. 

The PD produces a binary number proportional to the phase and frequency difference between the reference and 
feedback signals. Based on these inputs, the ALU determines the correct digital control codes to send to the delay 

Signal I/O Description 

CLKI I Clock input from external pin or routing 

CLKFB I PLL feedback input from CLKOP, CLKOS, or from a user clock (pin or logic) 

RST I “1” to reset PLL counters, VCO, charge pumps and M-dividers

RSTK I “1” to reset K-divider

WRDEL I DPA Fine Delay Adjust input

CLKOS O PLL output to clock tree (phase shifted/duty cycle changed) 

CLKOP O PLL output to clock tree (no phase shift) 

CLKOK O PLL output to clock tree through secondary clock divider 

CLKOK2 O PLL output to clock tree (CLKOP divided by 3)

LOCK O “1” indicates PLL LOCK to CLKI 

FDA [3:0] I Dynamic fine delay adjustment on CLKOS output

DRPAI[3:0] I Dynamic coarse phase shift, rising edge setting

DFPAI[3:0] I Dynamic coarse phase shift, falling edge setting 
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Figure 2-16. Per Region Secondary Clock Selection

Slice Clock Selection
Figure 2-17 shows the clock selections and Figure 2-18 shows the control selections for Slice0 through Slice2. All 
the primary clocks and seven secondary clocks are routed to this clock selection mux. Other signals can be used 
as a clock input to the slices via routing. Slice controls are generated from the secondary clocks/controls or other 
signals connected via routing.

If none of the signals are selected for both clock and control then the default value of the mux output is 1. Slice 3 
does not have any registers; therefore it does not have the clock or control muxes.

Figure 2-17. Slice0 through Slice2 Clock Selection

Figure 2-18. Slice0 through Slice2 Control Selection
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MMAC DSP Element
The LatticeECP3 supports a MAC with two multipliers. This is called Multiply Multiply Accumulate or MMAC. In this 
case, the two operands, AA and AB, are multiplied and the result is added with the previous accumulated value and 
with the result of the multiplier operation of operands BA and BB. This accumulated value is available at the output. 
The user can enable the input and pipeline registers, but the output register is always enabled. The output register 
is used to store the accumulated value. The ALU is configured as the accumulator in the sysDSP slice. A registered 
overflow signal is also available. The overflow conditions are provided later in this document. Figure 2-28 shows the 
MMAC sysDSP element. 

Figure 2-28. MMAC sysDSP Element
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MULTADDSUBSUM DSP Element
In this case, the operands AA and AB are multiplied and the result is added/subtracted with the result of the multi-
plier operation of operands BA and BB of Slice 0. Additionally, the operands AA and AB are multiplied and the 
result is added/subtracted with the result of the multiplier operation of operands BA and BB of Slice 1. The results 
of both addition/subtractions are added by the second ALU following the slice cascade path. The user can enable 
the input, output and pipeline registers. Figure 2-30 and Figure 2-31 show the MULTADDSUBSUM sysDSP ele-
ment.

Figure 2-30. MULTADDSUBSUM Slice 0
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Control Logic Block 
The control logic block allows the selection and modification of control signals for use in the PIO block. 

DDR Memory Support 
Certain PICs have additional circuitry to allow the implementation of high-speed source synchronous and DDR, 
DDR2 and DDR3 memory interfaces. The support varies by the edge of the device as detailed below.

Left and Right Edges
The left and right sides of the PIC have fully functional elements supporting DDR, DDR2, and DDR3 memory inter-
faces. One of every 12 PIOs supports the dedicated DQS pins with the DQS control logic block. Figure 2-35 shows 
the DQS bus spanning 11 I/O pins. Two of every 12 PIOs support the dedicated DQS and DQS# pins with the DQS 
control logic block.

Bottom Edge
PICs on the bottom edge of the device do not support DDR memory and Generic DDR interfaces. 

Top Edge
PICs on the top side are similar to the PIO elements on the left and right sides but do not support gearing on the 
output registers. Hence, the modes to support output/tristate DDR3 memory are removed on the top side.

The exact DQS pins are shown in a dual function in the Logic Signal Connections table in this data sheet. Addi-
tional detail is provided in the Signal Descriptions table. The DQS signal from the bus is used to strobe the DDR 
data from the memory into input register blocks. Interfaces on the left, right and top edges are designed for DDR 
memories that support 10 bits of data.

Figure 2-35. DQS Grouping on the Left, Right and Top Edges
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DLL Calibrated DQS Delay Block 
Source synchronous interfaces generally require the input clock to be adjusted in order to correctly capture data at 
the input register. For most interfaces, a PLL is used for this adjustment. However, in DDR memories the clock 
(referred to as DQS) is not free-running so this approach cannot be used. The DQS Delay block provides the 
required clock alignment for DDR memory interfaces.

The delay required for the DQS signal is generated by two dedicated DLLs (DDR DLL) on opposite side of the 
device. Each DLL creates DQS delays in its half of the device as shown in Figure 2-36. The DDR DLL on the left 
side will generate delays for all the DQS Strobe pins on Banks 0, 7 and 6 and DDR DLL on the right will generate 
delays for all the DQS pins on Banks 1, 2 and 3. The DDR DLL loop compensates for temperature, voltage and pro-
cess variations by using the system clock and DLL feedback loop. DDR DLL communicates the required delay to 
the DQS delay block using a 7-bit calibration bus (DCNTL[6:0])

The DQS signal (selected PIOs only, as shown in Figure 2-35) feeds from the PAD through a DQS control logic 
block to a dedicated DQS routing resource. The DQS control logic block consists of DQS Read Control logic block 
that generates control signals for the read side and DQS Write Control logic that generates the control signals 
required for the write side. A more detailed DQS control diagram is shown in Figure 2-37, which shows how the 
DQS control blocks interact with the data paths.

The DQS Read control logic receives the delay generated by the DDR DLL on its side and delays the incoming 
DQS signal by 90 degrees. This delayed ECLKDQSR is routed to 10 or 11 DQ pads covered by that DQS signal. 
This block also contains a polarity control logic that generates a DDRCLKPOL signal, which controls the polarity of 
the clock to the sync registers in the input register blocks. The DQS Read control logic also generates a DDRLAT 
signal that is in the input register block to transfer data from the first set of DDR register to the second set of DDR 
registers when using the DDRX2 gearbox mode for DDR3 memory interface.

The DQS Write control logic block generates the DQCLK0 and DQCLK1 clocks used to control the output gearing 
in the Output register block which generates the DDR data output and the DQS output. They are also used to con-
trol the generation of the DQS output through the DQS output register block. In addition to the DCNTL [6:0] input 
from the DDR DLL, the DQS Write control block also uses a Dynamic Delay DYN DEL [7:0] attribute which is used 
to further delay the DQS to accomplish the write leveling found in DDR3 memory. Write leveling is controlled by the 
DDR memory controller implementation. The DYN DELAY can set 128 possible delay step settings. In addition, the 
most significant bit will invert the clock for a 180-degree shift of the incoming clock. This will generate the DQSW 
signal used to generate the DQS output in the DQS output register block.

Figure 2-36 and Figure 2-37 show how the DQS transition signals that are routed to the PIOs.

Please see TN1180, LatticeECP3 High-Speed I/O Interface for more information on this topic.

www.latticesemi.com/dynamic/view_document.cfm?document_id=32320
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SCI (SERDES Client Interface) Bus
The SERDES Client Interface (SCI) is an IP interface that allows the SERDES/PCS Quad block to be controlled by 
registers rather than the configuration memory cells. It is a simple register configuration interface that allows 
SERDES/PCS configuration without power cycling the device.

The Diamond and ispLEVER design tools support all modes of the PCS. Most modes are dedicated to applications 
associated with a specific industry standard data protocol. Other more general purpose modes allow users to 
define their own operation. With these tools, the user can define the mode for each quad in a design. 

Popular standards such as 10Gb Ethernet, x4 PCI Express and 4x Serial RapidIO can be implemented using IP 
(available through Lattice), a single quad (Four SERDES channels and PCS) and some additional logic from the 
core. 

The LatticeECP3 family also supports a wide range of primary and secondary protocols. Within the same quad, the 
LatticeECP3 family can support mixed protocols with semi-independent clocking as long as the required clock fre-
quencies are integer x1, x2, or x11 multiples of each other. Table 2-15 lists the allowable combination of primary 
and secondary protocol combinations. 

Flexible Quad SERDES Architecture
The LatticeECP3 family SERDES architecture is a quad-based architecture. For most SERDES settings and stan-
dards, the whole quad (consisting of four SERDES) is treated as a unit. This helps in silicon area savings, better 
utilization and overall lower cost.

However, for some specific standards, the LatticeECP3 quad architecture provides flexibility; more than one stan-
dard can be supported within the same quad.

Table 2-15 shows the standards can be mixed and matched within the same quad. In general, the SERDES stan-
dards whose nominal data rates are either the same or a defined subset of each other, can be supported within the 
same quad. In Table 2-15, the Primary Protocol column refers to the standard that determines the reference clock 
and PLL settings. The Secondary Protocol column shows the other standard that can be supported within the 
same quad.

Furthermore, Table 2-15 also implies that more than two standards in the same quad can be supported, as long as 
they conform to the data rate and reference clock requirements. For example, a quad may contain PCI Express 1.1, 
SGMII, Serial RapidIO Type I and Serial RapidIO Type II, all in the same quad.

Table 2-15. LatticeECP3 Primary and Secondary Protocol Support

Primary Protocol Secondary Protocol

PCI Express 1.1 SGMII

PCI Express 1.1 Gigabit Ethernet

PCI Express 1.1 Serial RapidIO Type I

PCI Express 1.1 Serial RapidIO Type II

Serial RapidIO Type I SGMII

Serial RapidIO Type I Gigabit Ethernet

Serial RapidIO Type II SGMII

Serial RapidIO Type II Gigabit Ethernet

Serial RapidIO Type II Serial RapidIO Type I

CPRI-3 CPRI-2 and CPRI-1

3G-SDI HD-SDI and SD-SDI
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sysI/O Single-Ended DC Electrical Characteristics

Input/Output 
Standard

VIL VIH  VOL
Max. (V)

VOH
Min. (V) IOL

1 (mA) IOH
1 (mA)Min. (V) Max. (V) Min. (V) Max. (V)

LVCMOS33 –0.3 0.8 2.0 3.6
0.4 VCCIO - 0.4 20, 16, 

12, 8, 4
–20, –16, 

–12, -8, –4

0.2 VCCIO - 0.2 0.1 –0.1

LVCMOS25 –0.3 0.7 1.7 3.6
0.4 VCCIO - 0.4 20, 16, 

12, 8, 4
–20, –16, 

–12, –8, –4

0.2 VCCIO - 0.2 0.1 –0.1

LVCMOS18 –0.3 0.35 VCCIO 0.65 VCCIO 3.6
0.4 VCCIO - 0.4 16, 12, 

8, 4
–16, –12,

–8, –4

0.2 VCCIO - 0.2 0.1 –0.1

LVCMOS15 –0.3 0.35 VCCIO 0.65 VCCIO 3.6
0.4 VCCIO - 0.4 8, 4 –8, –4

0.2 VCCIO - 0.2 0.1 –0.1

LVCMOS12 –0.3 0.35 VCC 0.65 VCC 3.6
0.4 VCCIO - 0.4 6, 2 –6, –2

0.2 VCCIO - 0.2 0.1 –0.1

LVTTL33 –0.3 0.8 2.0 3.6
0.4 VCCIO - 0.4 20, 16, 

12, 8, 4
–20, –16, 

–12, –8, –4

0.2 VCCIO - 0.2 0.1 –0.1

PCI33 –0.3 0.3 VCCIO 0.5 VCCIO 3.6 0.1 VCCIO 0.9 VCCIO 1.5 –0.5

SSTL18_I –0.3 VREF - 0.125 VREF + 0.125 3.6 0.4 VCCIO - 0.4 6.7 –6.7

SSTL18_II
(DDR2 Memory) –0.3 VREF - 0.125 VREF + 0.125 3.6 0.28 VCCIO - 0.28

8 –8

11 –11

SSTL2_I –0.3 VREF - 0.18 VREF + 0.18 3.6 0.54 VCCIO - 0.62
7.6 –7.6

12 –12

SSTL2_II
(DDR Memory) –0.3 VREF - 0.18 VREF + 0.18 3.6 0.35 VCCIO - 0.43

15.2 –15.2

20 –20

SSTL3_I –0.3 VREF - 0.2 VREF + 0.2 3.6 0.7 VCCIO - 1.1 8 –8

SSTL3_II –0.3 VREF - 0.2 VREF + 0.2 3.6 0.5 VCCIO - 0.9 16 –16

SSTL15 
(DDR3 Memory) –0.3 VREF - 0.1 VREF + 0.1 3.6 0.3

VCCIO - 0.3 7.5 –7.5

VCCIO * 0.8 9 –9

HSTL15_I –0.3 VREF - 0.1 VREF + 0.1 3.6 0.4 VCCIO - 0.4
4 –4

8 –8

HSTL18_I –0.3 VREF - 0.1 VREF + 0.1 3.6 0.4 VCCIO - 0.4
8 –8

12 –12

HSTL18_II –0.3 VREF - 0.1 VREF + 0.1 3.6 0.4 VCCIO - 0.4 16 –16

1. For electromigration, the average DC current drawn by I/O pads between two consecutive VCCIO or GND pad connections, or between the 
last VCCIO or GND in an I/O bank and the end of an I/O bank, as shown in the Logic Signal Connections table (also shown as I/O grouping) 
shall not exceed n * 8 mA, where n is the number of I/O pads between the two consecutive bank VCCIO or GND connections or between the 
last VCCIO and GND in a bank and the end of a bank. IO Grouping can be found in the Data Sheet Pin Tables, which can also be generated 
from the Lattice Diamond software.
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, 2Derating Timing Tables
Logic timing provided in the following sections of this data sheet and the Diamond and ispLEVER design tools are 
worst case numbers in the operating range. Actual delays at nominal temperature and voltage for best case pro-
cess, can be much better than the values given in the tables. The Diamond and ispLEVER design tools can provide 
logic timing numbers at a particular temperature and voltage.

18x18 Multiply/Accumulate (Input & Output Registers) 200 MHz

18x18 Multiply-Add/Sub (All Registers) 400 MHz

1. These timing numbers were generated using ispLEVER tool. Exact performance may vary with device and tool version. The tool uses inter-
nal parameters that have been characterized but are not tested on every device.

2. Commercial timing numbers are shown. Industrial numbers are typically slower and can be extracted from the Diamond or ispLEVER soft-
ware.

3. For details on -9 speed grade devices, please contact your Lattice Sales Representative.

Register-to-Register Performance1, 2, 3

 Function –8 Timing Units
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tHWREN_EBR Hold Write/Read Enable to EBR Memory 0.141 — 0.145 — 0.149 — ns

tSUCE_EBR
Clock Enable Setup Time to EBR Output 
Register 0.087 — 0.096 — 0.104 — ns

tHCE_EBR
Clock Enable Hold Time to EBR Output 
Register –0.066 — –0.080 — –0.094 — ns

tSUBE_EBR
Byte Enable Set-Up Time to EBR Output 
Register –0.071 — –0.070 — –0.068 — ns

tHBE_EBR
Byte Enable Hold Time to EBR Output 
Register 0.118 — 0.098 — 0.077 — ns

DSP Block Timing3

tSUI_DSP Input Register Setup Time 0.32 — 0.36 — 0.39 — ns

tHI_DSP Input Register Hold Time  –0.17 — –0.19 — –0.21 — ns

tSUP_DSP Pipeline Register Setup Time 2.23 — 2.30 — 2.37 — ns

tHP_DSP Pipeline Register Hold Time –1.02 — –1.09 — –1.15 — ns

tSUO_DSP Output Register Setup Time 3.09 — 3.22 — 3.34 — ns

tHO_DSP Output Register Hold Time –1.67 — –1.76 — –1.84 — ns

tCOI_DSP Input Register Clock to Output Time — 3.05 — 3.35 — 3.73 ns

tCOP_DSP Pipeline Register Clock to Output Time — 1.30 — 1.47 — 1.64 ns

tCOO_DSP Output Register Clock to Output Time — 0.58 — 0.60 — 0.62 ns

tSUOPT_DSP Opcode Register Setup Time 0.31 — 0.35 — 0.39 — ns

tHOPT_DSP Opcode Register Hold Time –0.20 — –0.24 — –0.27 — ns

tSUDATA_DSP
Cascade_data through ALU to Output 
Register Setup Time 1.69 — 1.94 — 2.14 — ns

tHPDATA_DSP
Cascade_data  through ALU to Output 
Register Hold Time –0.58 — –0.80 — –0.97 — ns

1. Internal parameters are characterized but not tested on every device.
2. Commercial timing numbers are shown. Industrial timing numbers are typically slower and can be extracted from the Diamond or ispLEVER 

software.
3. DSP slice is configured in Multiply Add/Sub 18 x 18 mode.
4. The output register is in Flip-flop mode.
5. For details on –9 speed grade devices, please contact your Lattice Sales Representative.

LatticeECP3 Internal Switching Characteristics1, 2, 5 (Continued)
Over Recommended Commercial Operating Conditions

Parameter Description

–8 –7 –6

Units.Min. Max. Min. Max. Min. Max.
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LatticeECP3 Family Timing Adders1, 2, 3, 4, 5, 7 
Over Recommended Commercial Operating Conditions

Buffer Type Description –8 –7 –6 Units

Input Adjusters 

LVDS25E LVDS, Emulated, VCCIO = 2.5 V 0.03 –0.01 –0.03 ns

LVDS25 LVDS, VCCIO = 2.5 V 0.03 0.00 –0.04 ns

BLVDS25 BLVDS, Emulated, VCCIO = 2.5 V 0.03 0.00 –0.04 ns

MLVDS25 MLVDS, Emulated, VCCIO = 2.5 V 0.03 0.00 –0.04 ns

RSDS25 RSDS, VCCIO = 2.5 V 0.03 –0.01 –0.03 ns

PPLVDS Point-to-Point LVDS 0.03 –0.01 –0.03 ns

TRLVDS Transition-Reduced LVDS 0.03 0.00 –0.04 ns

Mini MLVDS Mini LVDS 0.03 –0.01 –0.03 ns

LVPECL33 LVPECL, Emulated, VCCIO = 3.3 V 0.17 0.23 0.28 ns

HSTL18_I HSTL_18 class I, VCCIO = 1.8 V 0.20 0.17 0.13 ns

HSTL18_II HSTL_18 class II, VCCIO = 1.8 V 0.20 0.17 0.13 ns

HSTL18D_I Differential HSTL 18 class I 0.20 0.17 0.13 ns

HSTL18D_II Differential HSTL 18 class II 0.20 0.17 0.13 ns

HSTL15_I HSTL_15 class I, VCCIO = 1.5 V 0.10 0.12 0.13 ns

HSTL15D_I Differential HSTL 15 class I 0.10 0.12 0.13 ns

SSTL33_I SSTL_3 class I, VCCIO = 3.3 V 0.17 0.23 0.28 ns

SSTL33_II SSTL_3 class II, VCCIO = 3.3 V 0.17 0.23 0.28 ns

SSTL33D_I Differential SSTL_3 class I 0.17 0.23 0.28 ns

SSTL33D_II Differential SSTL_3 class II 0.17 0.23 0.28 ns

SSTL25_I SSTL_2 class I, VCCIO = 2.5 V 0.12 0.14 0.16 ns

SSTL25_II SSTL_2 class II, VCCIO = 2.5 V 0.12 0.14 0.16 ns

SSTL25D_I Differential SSTL_2 class I 0.12 0.14 0.16 ns

SSTL25D_II Differential SSTL_2 class II 0.12 0.14 0.16 ns

SSTL18_I SSTL_18 class I, VCCIO = 1.8 V 0.08 0.06 0.04 ns

SSTL18_II SSTL_18 class II, VCCIO = 1.8 V 0.08 0.06 0.04 ns

SSTL18D_I Differential SSTL_18 class I 0.08 0.06 0.04 ns

SSTL18D_II Differential SSTL_18 class II 0.08 0.06 0.04 ns

SSTL15 SSTL_15, VCCIO = 1.5 V 0.087 0.059 0.032 ns

SSTL15D Differential SSTL_15 0.087 0.059 0.032 ns

LVTTL33 LVTTL, VCCIO = 3.3 V 0.07 0.07 0.07 ns

LVCMOS33 LVCMOS, VCCIO = 3.3 V 0.07 0.07 0.07 ns

LVCMOS25 LVCMOS, VCCIO = 2.5 V 0.00 0.00 0.00 ns

LVCMOS18 LVCMOS, VCCIO = 1.8 V –0.13 –0.13 –0.13 ns

LVCMOS15 LVCMOS, VCCIO = 1.5 V –0.07 –0.07 –0.07 ns

LVCMOS12 LVCMOS, VCCIO = 1.2 V –0.20 –0.19 –0.19 ns

PCI33 PCI, VCCIO = 3.3 V 0.07 0.07 0.07 ns

Output Adjusters 

LVDS25E LVDS, Emulated, VCCIO = 2.5 V 1.02 1.14 1.26 ns

LVDS25 LVDS, VCCIO = 2.5 V –0.11 –0.07 –0.03 ns

BLVDS25 BLVDS, Emulated, VCCIO = 2.5 V 1.01 1.13 1.25 ns

MLVDS25 MLVDS, Emulated, VCCIO = 2.5 V 1.01 1.13 1.25 ns
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RSDS25 RSDS, VCCIO = 2.5 V –0.07 –0.04 –0.01 ns

PPLVDS Point-to-Point LVDS, True LVDS, VCCIO = 2.5 V or 3.3 V –0.22 –0.19 –0.16 ns

LVPECL33 LVPECL, Emulated, VCCIO = 3.3 V 0.67 0.76 0.86 ns

HSTL18_I HSTL_18 class I 8mA drive, VCCIO = 1.8 V 1.20 1.34 1.47 ns

HSTL18_II HSTL_18 class II, VCCIO = 1.8 V 0.89 1.00 1.11 ns

HSTL18D_I Differential HSTL 18 class I 8 mA drive 1.20 1.34 1.47 ns

HSTL18D_II Differential HSTL 18 class II 0.89 1.00 1.11 ns

HSTL15_I HSTL_15 class I 4 mA drive, VCCIO = 1.5 V 1.67 1.83 1.99 ns

HSTL15D_I Differential HSTL 15 class I 4 mA drive 1.67 1.83 1.99 ns

SSTL33_I SSTL_3 class I, VCCIO = 3.3 V 1.12 1.17 1.21 ns

SSTL33_II SSTL_3 class II, VCCIO = 3.3 V 1.08 1.12 1.15 ns

SSTL33D_I Differential SSTL_3 class I 1.12 1.17 1.21 ns

SSTL33D_II Differential SSTL_3 class II 1.08 1.12 1.15 ns

SSTL25_I SSTL_2 class I 8 mA drive, VCCIO = 2.5 V 1.06 1.19 1.31 ns

SSTL25_II SSTL_2 class II 16 mA drive, VCCIO = 2.5 V 1.04 1.17 1.31 ns

SSTL25D_I Differential SSTL_2 class I 8 mA drive 1.06 1.19 1.31 ns

SSTL25D_II Differential SSTL_2 class II 16 mA drive 1.04 1.17 1.31 ns

SSTL18_I SSTL_1.8 class I, VCCIO = 1.8 V 0.70 0.84 0.97 ns

SSTL18_II SSTL_1.8 class II 8 mA drive, VCCIO = 1.8 V 0.70 0.84 0.97 ns

SSTL18D_I Differential SSTL_1.8 class I 0.70 0.84 0.97 ns

SSTL18D_II Differential SSTL_1.8 class II 8 mA drive 0.70 0.84 0.97 ns

SSTL15 SSTL_1.5, VCCIO = 1.5 V 1.22 1.35 1.48 ns

SSTL15D Differential SSTL_15 1.22 1.35 1.48 ns

LVTTL33_4mA LVTTL 4 mA drive, VCCIO = 3.3V 0.25 0.24 0.23 ns

LVTTL33_8mA LVTTL 8 mA drive, VCCIO = 3.3V –0.06 –0.06 –0.07 ns

LVTTL33_12mA LVTTL 12 mA drive, VCCIO = 3.3V –0.01 –0.02 –0.02 ns

LVTTL33_16mA LVTTL 16 mA drive, VCCIO = 3.3V –0.07 –0.07 –0.08 ns

LVTTL33_20mA LVTTL 20 mA drive, VCCIO = 3.3V –0.12 –0.13 –0.14 ns

LVCMOS33_4mA LVCMOS 3.3 4 mA drive, fast slew rate 0.25 0.24 0.23 ns

LVCMOS33_8mA LVCMOS 3.3 8 mA drive, fast slew rate –0.06 –0.06 –0.07 ns

LVCMOS33_12mA LVCMOS 3.3 12 mA drive, fast slew rate –0.01 –0.02 –0.02 ns

LVCMOS33_16mA LVCMOS 3.3 16 mA drive, fast slew rate –0.07 –0.07 –0.08 ns

LVCMOS33_20mA LVCMOS 3.3 20 mA drive, fast slew rate –0.12 –0.13 –0.14 ns

LVCMOS25_4mA LVCMOS 2.5 4 mA drive, fast slew rate 0.12 0.10 0.09 ns

LVCMOS25_8mA LVCMOS 2.5 8 mA drive, fast slew rate –0.05 –0.06 –0.07 ns

LVCMOS25_12mA LVCMOS 2.5 12 mA drive, fast slew rate 0.00 0.00 0.00 ns

LVCMOS25_16mA LVCMOS 2.5 16 mA drive, fast slew rate –0.12 –0.13 –0.14 ns

LVCMOS25_20mA LVCMOS 2.5 20 mA drive, fast slew rate –0.12 –0.13 –0.14 ns

LVCMOS18_4mA LVCMOS 1.8 4 mA drive, fast slew rate 0.11 0.12 0.14 ns

LVCMOS18_8mA LVCMOS 1.8 8 mA drive, fast slew rate 0.11 0.12 0.14 ns

LVCMOS18_12mA LVCMOS 1.8 12 mA drive, fast slew rate –0.04 –0.03 –0.03 ns

LVCMOS18_16mA LVCMOS 1.8 16 mA drive, fast slew rate –0.04 –0.03 –0.03 ns

LatticeECP3 Family Timing Adders1, 2, 3, 4, 5, 7 (Continued)
Over Recommended Commercial Operating Conditions

Buffer Type Description –8 –7 –6 Units
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Figure 3-14. Jitter Transfer – 3.125 Gbps

Figure 3-15. Jitter Transfer – 2.5 Gbps
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Gigabit Ethernet/Serial Rapid I/O Type 1/SGMII/CPRI LV E.12 Electrical and 
Timing Characteristics
AC and DC Characteristics
Table 3-17. Transmit

Table 3-18. Receive and Jitter Tolerance

Symbol Description Test Conditions Min. Typ. Max. Units

TRF Differential rise/fall time 20%-80% — 80 — ps

ZTX_DIFF_DC Differential impedance 80 100 120 Ohms

JTX_DDJ
3, 4, 5 Output data deterministic jitter — — 0.10 UI

JTX_TJ
2, 3, 4, 5 Total output data jitter — — 0.24 UI

1. Rise and fall times measured with board trace, connector and approximately 2.5 pf load.
2. Total jitter includes both deterministic jitter and random jitter. The random jitter is the total jitter minus the actual deterministic jitter.
3. Jitter values are measured with each CML output AC coupled into a 50-Ohm impedance (100-Ohm differential impedance).
4. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
5. Values are measured at 1.25 Gbps.

Symbol Description Test Conditions Min. Typ. Max. Units

RLRX_DIFF Differential return loss From 100 MHz to 1.25 GHz 10 — — dB

RLRX_CM Common mode return loss From 100 MHz to 1.25 GHz 6 — — dB

ZRX_DIFF Differential termination resistance 80 100 120 Ohms

JRX_DJ
1, 2, 3, 4, 5 Deterministic jitter tolerance (peak-to-peak) — — 0.34 UI

JRX_RJ
1, 2, 3, 4, 5 Random jitter tolerance (peak-to-peak) — — 0.26 UI

JRX_SJ
1, 2, 3, 4, 5 Sinusoidal jitter tolerance (peak-to-peak) — — 0.11 UI

JRX_TJ
1, 2, 3, 4, 5 Total jitter tolerance (peak-to-peak) — — 0.71 UI

TRX_EYE Receiver eye opening 0.29 — — UI

1. Total jitter includes deterministic jitter, random jitter and sinusoidal jitter. The sinusoidal jitter tolerance mask is shown in Figure 3-18.
2. Jitter values are measured with each high-speed input AC coupled into a 50-Ohm impedance.
3. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
4. Jitter tolerance, Differential Input Sensitivity and Receiver Eye Opening parameters are characterized when Full Rx Equalization is enabled.
5. Values are measured at 1.25 Gbps.
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Figure 3-19. Test Loads
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PICs and DDR Data (DQ) Pins Associated with the DDR Strobe (DQS) Pin
PICs Associated with 

DQS Strobe PIO Within PIC
DDR Strobe (DQS) and 

Data (DQ) Pins

For Left and Right Edges of the Device

P[Edge] [n-3] 
A DQ 

B DQ 

P[Edge] [n-2] 
A DQ 

B DQ 

P[Edge] [n-1] 
A DQ

B DQ 

P[Edge] [n] 
A [Edge]DQSn

B DQ 

P[Edge] [n+1] 
A DQ 

B DQ 

P[Edge] [n+2] 
A DQ 

B DQ 

For Top Edge of the Device

P[Edge] [n-3] 
A DQ 

B DQ 

P[Edge] [n-2] 
A DQ 

B DQ 

P[Edge] [n-1] 
A DQ 

B DQ 

P[Edge] [n] 
A [Edge]DQSn 

B DQ 

P[Edge] [n+1] 
A DQ 

B DQ 

P[Edge] [n+2] 
A DQ 

B DQ 

Note: “n” is a row PIC number. 
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Package Pinout Information
Package pinout information can be found under “Data Sheets” on the LatticeECP3 product pages on the Lattice 
website at http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3 and in the Diamond or ispLEVER 
software tools. To create pinout information from within ispLEVER Design Planner, select Tools > Spreadsheet 
View. Then select Select File > Export and choose a type of output file. To create a pin information file from within 
Diamond select Tools > Spreadsheet View or Tools >Package View; then, select File > Export and choose a 
type of output file. See Diamond or ispLEVER Help for more information.

Thermal Management 
Thermal management is recommended as part of any sound FPGA design methodology. To assess the thermal 
characteristics of a system, Lattice specifies a maximum allowable junction temperature in all device data sheets. 
Designers must complete a thermal analysis of their specific design to ensure that the device and package do not 
exceed the junction temperature limits. Refer to the Thermal Management document to find the device/package 
specific thermal values.

For Further Information
For further information regarding Thermal Management, refer to the following:

• Thermal Management document

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• Power Calculator tool included with the Diamond and ispLEVER design tools, or as a standalone download from 
www.latticesemi.com/software

http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.aspx
www.latticesemi.com/dynamic/view_document.cfm?document_id=210
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
http://www.latticesemi.com/products/designsoftware/index.cfm
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Industrial

The following devices may have associated errata. Specific devices with associated errata will be notated with a 
footnote.

Part Number Voltage Grade Power Package1 Pins Temp. LUTs (K) 

LFE3-17EA-6FTN256I 1.2 V –6 STD Lead-Free ftBGA 256 IND 17

LFE3-17EA-7FTN256I 1.2 V –7 STD Lead-Free ftBGA 256 IND 17

LFE3-17EA-8FTN256I 1.2 V –8 STD Lead-Free ftBGA 256 IND 17

LFE3-17EA-6LFTN256I 1.2 V –6 LOW Lead-Free ftBGA 256 IND 17

LFE3-17EA-7LFTN256I 1.2 V –7 LOW Lead-Free ftBGA 256 IND 17

LFE3-17EA-8LFTN256I 1.2 V –8 LOW Lead-Free ftBGA 256 IND 17

LFE3-17EA-6MG328I 1.2 V –6 STD Lead-Free csBGA 328 IND 17

LFE3-17EA-7MG328I 1.2 V –7 STD Lead-Free csBGA 328 IND 17

LFE3-17EA-8MG328I 1.2 V –8 STD Lead-Free csBGA 328 IND 17

LFE3-17EA-6LMG328I 1.2 V –6 LOW Green csBGA 328 IND 17

LFE3-17EA-7LMG328I 1.2 V –7 LOW Green csBGA 328 IND 17

LFE3-17EA-8LMG328I 1.2 V –8 LOW Green csBGA 328 IND 17

LFE3-17EA-6FN484I 1.2 V –6 STD Lead-Free fpBGA 484 IND 17

LFE3-17EA-7FN484I 1.2 V –7 STD Lead-Free fpBGA 484 IND 17

LFE3-17EA-8FN484I 1.2 V –8 STD Lead-Free fpBGA 484 IND 17

LFE3-17EA-6LFN484I 1.2 V –6 LOW Lead-Free fpBGA 484 IND 17

LFE3-17EA-7LFN484I 1.2 V –7 LOW Lead-Free fpBGA 484 IND 17

LFE3-17EA-8LFN484I 1.2 V –8 LOW Lead-Free fpBGA 484 IND 17

1. Green = Halogen free and lead free.

Part Number Voltage Grade1 Power Package Pins Temp. LUTs (K) 

LFE3-35EA-6FTN256I 1.2 V –6 STD Lead-Free ftBGA 256 IND 33

LFE3-35EA-7FTN256I 1.2 V –7 STD Lead-Free ftBGA 256 IND 33

LFE3-35EA-8FTN256I 1.2 V –8 STD Lead-Free ftBGA 256 IND 33

LFE3-35EA-6LFTN256I 1.2 V –6 LOW Lead-Free ftBGA 256 IND 33

LFE3-35EA-7LFTN256I 1.2 V –7 LOW Lead-Free ftBGA 256 IND 33

LFE3-35EA-8LFTN256I 1.2 V –8 LOW Lead-Free ftBGA 256 IND 33

LFE3-35EA-6FN484I 1.2 V –6 STD Lead-Free fpBGA 484 IND 33

LFE3-35EA-7FN484I 1.2 V –7 STD Lead-Free fpBGA 484 IND 33

LFE3-35EA-8FN484I 1.2 V –8 STD Lead-Free fpBGA 484 IND 33

LFE3-35EA-6LFN484I 1.2 V –6 LOW Lead-Free fpBGA 484 IND 33

LFE3-35EA-7LFN484I 1.2 V –7 LOW Lead-Free fpBGA 484 IND 33

LFE3-35EA-8LFN484I 1.2 V –8 LOW Lead-Free fpBGA 484 IND 33

LFE3-35EA-6FN672I 1.2 V –6 STD Lead-Free fpBGA 672 IND 33

LFE3-35EA-7FN672I 1.2 V –7 STD Lead-Free fpBGA 672 IND 33

LFE3-35EA-8FN672I 1.2 V –8 STD Lead-Free fpBGA 672 IND 33

LFE3-35EA-6LFN672I 1.2 V –6 LOW Lead-Free fpBGA 672 IND 33

LFE3-35EA-7LFN672I 1.2 V –7 LOW Lead-Free fpBGA 672 IND 33

LFE3-35EA-8LFN672I 1.2 V –8 LOW Lead-Free fpBGA 672 IND 33

1. For ordering information on -9 speed grade devices, please contact your Lattice Sales Representative.
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LatticeECP3 Maximum I/O Buffer Speed table – Description column, 
references to VCCIO = 3.0V changed to 3.3V.

Updated SERDES External Reference Clock Waveforms.

Transmitter and Receiver Latency Block Diagram – Updated sections of 
the diagram to match descriptions on the SERDES/PCS Latency Break-
down table. 

Pinout Information “Logic Signal Connections” section heading renamed “Package Pinout 
Information”. Software menu selections within this section have been 
updated.

Signal Descriptions table – Updated description for VCCA signal.

April 2012 02.2EA Architecture Updated first paragraph of Output Register Block section.

Updated the information about sysIO buffer pairs below Figure 2-38.

Updated the information relating to migration between devices in the 
Density Shifting section.

DC and Switching
Characteristics

Corrected the Definitions in the sysCLOCK PLL Timing table for tRST.

Ordering Information Updated topside marks with new logos in the Ordering Information sec-
tion.

February 2012 02.1EA All Updated document with new corporate logo.

November 2011 02.0EA Introduction Added information for LatticeECP3-17EA, 328-ball csBGA package.

Architecture Added information for LatticeECP3-17EA, 328-ball csBGA package.

DC and Switching 
Characteristics

Updated LatticeECP3 Supply Current table power numbers.

Typical Building Block Function Performance table, LatticeECP3 Exter-
nal Switching Characteristics table, LatticeECP3 Internal Switching 
Characteristics table and LatticeECP3 Family Timing Adders: Added 
speed grade -9 and updated speed grade -8, -7 and -6 timing numbers. 

Pinout Information Added information for LatticeECP3-17EA, 328-ball csBGA package.

Ordering Information Added information for LatticeECP3-17EA, 328-ball csBGA package.

Added ordering information for low power devices and -9 speed grade 
devices.

July 2011 01.9EA DC and Switching 
Characteristics

Removed ESD Performance table and added reference to LatticeECP3 
Product Family Qualification Summary document.

sysCLOCK PLL TIming table, added footnote 4.

External Reference Clock Specification table – removed reference to 
VREF-CM-AC and removed footnote for VREF-CM-AC.

Pinout Information Pin Information Summary table: Corrected VCCIO Bank8 data for
LatticeECP3-17EA 256-ball ftBGA package and LatticeECP-35EA 256-
ball ftBGA package.

April 2011 01.8EA Architecture Updated Secondary Clock/Control Sources text section.

DC and Switching 
Characteristics

Added data for 150 Mbps to SERDES Power Supply Requirements 
table.

Updated Frequencies in Table 3-6 Serial Output Timing and Levels

Added Data for 150 Mbps to Table 3-7 Channel Output Jitter

Corrected External Switching Characteristics table, Description for 
DDR3 Clock Timing, tJIT.

Corrected Internal Switching Characteristics table, Description for EBR 
Timing, tSUWREN_EBR and tHWREN_EBR.

Added footnote 1 to sysConfig Port Timing Specifications table.

Updated description for RX-CIDs to 150M in Table 3-9 Serial Input Data 
Specifications

Date Version Section Change Summary
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March 2010 01.6 Architecture Added Read-Before-Write information.

DC and Switching 
Characteristics

Added footnote #6 to Maximum I/O Buffer Speed table.

Corrected minimum operating conditions for input and output differential 
voltages in the Point-to-Point LVDS table.

Pinout Information Added pin information for the LatticeECP3-70EA and LatticeECP3-
95EA devices.

Ordering Information Added ordering part numbers for the LatticeECP3-70EA and 
LatticeECP3-95EA devices.

Removed dual mark information.

November 2009 01.5 Introduction Updated Embedded SERDES features.

Added SONET/SDH to Embedded SERDES protocols.

Architecture Updated Figure 2-4, General Purpose PLL Diagram.

Updated SONET/SDH to SERDES and PCS protocols.

Updated Table 2-13, SERDES Standard Support to include SONET/
SDH and updated footnote 2.

DC and Switching
Characterisitcs

Added footnote to ESD Performance table.

Updated SERDES Power Supply Requirements table and footnotes.

Updated Maximum I/O Buffer Speed table.

Updated Pin-to-Pin Peformance table.

Updated sysCLOCK PLL Timing table.

Updated DLL timing table.

Updated High-Speed Data Transmitter tables.

Updated High-Speed Data Receiver table.

Updated footnote for Receiver Total Jitter Tolerance Specification table.

Updated Periodic Receiver Jitter Tolerance Specification table.

Updated SERDES External Reference Clock Specification table.

Updated PCI Express Electrical and Timing AC and DC Characteristics.

Deleted Reference Clock table for PCI Express Electrical and Timing 
AC and DC Characteristics.

Updated SMPTE AC/DC Characteristics Transmit table.

Updated Mini LVDS table.

Updated RSDS table.

Added Supply Current (Standby) table for EA devices.

Updated Internal Switching Characteristics table.

Updated Register-to-Register Performance table.

Added HDMI Electrical and Timing Characteristics data.

Updated Family Timing Adders table.

Updated sysCONFIG Port Timing Specifications table.

Updated Recommended Operating Conditions table.

Updated Hot Socket Specifications table.

Updated Single-Ended DC table.

Updated TRLVDS table and figure.

Updated Serial Data Input Specifications table.

Updated HDMI Transmit and Receive table.

Ordering Information Added LFE3-150EA “TW” devices and footnotes to the Commercial and 
Industrial tables.

Date Version Section Change Summary


